Lab Session 1

Introduction and Bare-metal ARM programming

Up to now we have been focusing on the use of a relatively simple 8-bit 8051 series
microprocessor. While this may be suitable for some low performance applications, it is
obvious that for more demanding applications such as a mobile phone we need something
more powerful. This lab will be rather easy and is intended to introduce the Texas
Instruments Sitara AM3358 ARM Cortex-A8 32-bit microprocessor and development

environment as well as the Beaglebone Black development board.

For this lab your development board is connected to two of your PC's USB ports. One USB
port is used to host the JTAG debugger and the second USB port will be configured as a
RS232 serial port. The JTAG debugger tool will connect into the Texas Instruments Code
Composer Studio software development tool and we will use it to download and execute
code to the Beaglebone board. The RS232/USB module will connect a UART on the

Beaglebone board to a terminal program such as Putty.

For this first lab we will be writing and compiling C code for the ARM processor but without
using an operating system. This is known as “bare metal” programming as the only code
within the system is the code that you write and compile. This is exactly like what we were
doing with the 8-bit, 8051 processor in the previous labs. The advantage of this method is
that you have full control over the resources and you often end up needing less memory. The

disadvantage is that you have to write everything.

For this lab you will need the following bits:

1. Beaglebone black development board with JTAG connector attached.
2. 5V power adapter.

3. Segger J-Link USB-JTAG module + JTAG cable and USB cable.

4. TTL-232R-3V3, UART to USB adaptor cable.

Step 1: Launch Code Composer Studio on your PC. It has a Rubik’s cube icon. Select the

“file” menu and then select “New” and then select “Project”. From the list of wizards that



appear, in the “C/C++” folder, select “CCS Project” and click “Next. A dialog box will

appear as below.

G Mew CCS Project O ¥
New CCS Project — L%
Create a new CCS Project. ; E"J
Target: AM33x - Cortex A3 ~ | | BeagleBone_Black w
Connection: | SEGGER J-Link Emulator ~ Verify...
4 Cortex A [Arm] Cortex M [Arm] PRU
Project name: | EEEM301Lab1Part1

Use default location
Chti\Mew folder\EEEN301Lab1Part1

Compiler version: GMNU v9.2.1 (Linara) w

b Project type and tool-chain

= Project ternplates and examples
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= - demonstrating a "semi-hosted” program,

v (=] Empty Projects printing the string "Hello World!" to standard
Iz Empty Project output through the debugger,
|5 Empty Project (with main.c)

~ [5] Basic Examples Although this is a simple example, it is not
"2 Hello World recommended for devices with small memory-

maps.

Open Rescurce Explorer to browse a wide selection of example projects...
Open |mport Wizard to find local example projects for selected device...

@' < Back Mext > Cancel

Choose the processor type, debugger connection, project name, project location, compiler
version and project template as per the picture above. In your case you will choose a location
on your H drive. Click finish when you are ready. Your project will now be automatically

generated.



To view the file structure of the program we need to open the Project Explorer. In the “View”
menu, click on “Project Explorer”. Expand your project tab within the “Project Explorer”
window and examine the project contents. The “hello.c” file contents should be visible in a

text editor window.

Step 2: Locate the button “S2” on the Beagle bone black board. It is the button at the opposite
end of the board from the “S1” RESET and “S3” Power buttons. Press this button and at the
same time connect the 5V power supply. Continue pressing this button for at least 30
seconds. The Beaglebone black has a preloaded Linux operating system stored in Flash
memory and this normally boots up when power is applied. By pressing “S2” when applying
power we are forcing the Beaglebone black to try and boot from a different source. In our

case there is nothing to boot so the processor halts.

Step 3: Connect the Segger JTAG debugger cable to the JTAG port of the Beaglebone black
board. You will notice that the connector is keyed. Next, connect the USB cable of the JTAG
debugger to a USB port of your PC.

Step 4: In Code Composer Studio, click on the little bug symbol to launch the debugger.
Click “accept” when the “terms of use” window pops up. The project will be compiled again,
but for debug purposes and the interface will change to a “debug” view environment. The
first time the project is “debugged” the window below will appear. We would like to load
our code onto the AM335x ARM Cortex A8 processor, therefore, Deselect the first box and
click OK.



The project EEEN301Lab1pt1 is compatible with multiple CPUs in the target configuration.

Please select the CPUs to load the program on. This selection will be associated with the active target configuration.

[[] SEGGER J-Link Emulator/M3_wakeupSSs_0
SEGGER J-Link Emulator/CortxA8

Select All Deselect All
[ create a debug group for selected cores
Make the group synchronous
©) Cancel

Step S: In the “Window” menu, select “Show View” and then select “Disassembly”. A new
window should appear showing the disassembled code. The program counter will be set to

the start of the program.

Step 6: Click the green “Resume” arrow (towards the left of the tool bar). The code will then
execute and you will then see the message “Hello World!” in the debug console window.
Click the red box to terminate the debug session. Try changing the message and then run the
code via debug. When finished, right click on the project within the project explorer and then

select “close project”.

Step 7: Download the zip file: EEEN301 lab1 pt2.zip. In Code Composer Studio, select file
menu and then “open projects from file system”. Click the “Archive” button and then select

the zip file. Finally, unselect the first option as per the figure below and then select finish.
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A new project will then be loaded. In the Project Explorer, double click on the project name
to make it active and then launch the program via debug. The active project will be
highlighted with bold text. When it runs you will see the 4 blue LEDs flash. Experiment

with the “LEDs.c” code, change the rate of the flashing and make some new patterns.

Step 8: Download the zip file: EEEN301 lab1 pt3.zip and load into Code Composer Studio.



Connect a USB/Serial cable as per the figure above. Open a terminal program (Tera-term or
Putty) and set the BAUD rate to 115200. You will need to use the Windows Device Manager
to discover the COM Port Number of your USB/Serial Cable. Run the code via debug and
you should see the message “UARTO Initialized...” appear in the window of the terminal
program. Type characters on the keyboard and you should see them being echoed to the
screen. This code demonstrates the use of the UART. Modify this program so that it displays
the lower 4 bits of the ASCII character onto the 4 blue LEDs.



Lab Session 2

JTAG Debugging

In the previous lab we investigated the execution of Bare-metal C code on the Beaglebone
ARM processor. To download and run the program we used the JTAG in system

programming features. For this lab we will investigate the Debug capabilities of ITAG.

Step 1: Power up the Beaglebone board in Bare-metal mode and then connect the SEGGER
JTAG debugger unit.

Step 2: Download the zip file: EEEN301 labl pt2.zip and load into Code Composer Studio.

Step 3: Click on the Debug button to launch the debug session. Bring up the disassembler

window to observe the loaded code.

Step 4: If the “Registers” window is not visible, you can open it using the “Window” menu,

clicking on “Show View” and then clicking on “Registers”. Expand the “Registers” window

as per below.

(9= Variables 7 Expressions (i!i Registers

Name Value
v 4% Core Registers

Description
Core Registers

HHPC 0x403008C4 Program Counter [Core]
nisp 0x40300800 General Purpose Register 13 [Core]
HHLR 0x40300894 General Purpose Register 14 [Core]

v {HCPSR 0x60000190 Stores the status of interrupt enables ai
TN (1] Stores bit 31 of the result of the instruc
Wz 1 Is set to 1 if the result of the aperation
fmic 1 Stores the value of the carry bit if it occ
v 0 Set to 1 if an overflow occurred
Hna ] Indicates whether an overflow or a satu
WIT_1.0 O IT state bits.

i) 0 Java State Bit.
1! Reserved 0000 Reserved.
1 GE 0000 Greater than or equal bits
iIT_7.2 000000 IT state bits
WE 0 If set, data memory is interpreted as bit
A 1 If set, any asynchronous abort is held p
i 1 If set, IRQ is disabled. If cleared IRQ is 2
T F 0 If set, FIQ is disabled. If cleared FIQ is a
mT 1] If set ARM is in Thumb mode
M 10000 Mode of ARM
Wi RO 0x00000000 General Purpose Register 0 [Core]
iRt 0x00000000 General Purpose Register 1 [Core]
WHR2 0x000059EB General Purpose Register 2 [Core]
#HR3 0x00001999 General Purpose Register 3 [Core]
Wi R4 0x00000000 General Purpose Register 4 [Core]

You will notice the PC (program counter register) has the value equal to the start address of

your loaded program. It is possible to change the value of the program counter or any other



register by clicking on the value inside the “Value” column. Try changing the value of RO.
This feature allows you to alter the contents of the registers while stepping through a

program.

Look at the start of the program and you will see the lines:
8000052C: ES2DE004 str Ir, [sp, #-4]!
80000530: E24DD00C sub  sp, sp, #0xc

Question 1: What do you think this code does?

Step 6: Click on the “Window” and then the “Show View” menus and select “Memory
Browser”. A new window should appear on the right of your screen. In the address entry
region, enter the value of the SP (0x8001F328). The contents of the stack region should

appear.

Step 6: Click on the small green “Step Into” arrow . This tells the debugger to execute
one single instruction. You will notice that in the disassembler window the green bar has
moved down one step. You should also notice the PC and SP registers and memory have

changed. This is indicated by the yellow highlighting.

Step 7: Click on a memory location in the memory view window and change the value. The
debugger then alters the memory on the Beaglebone board. This feature allows you to alter

the memory as you step through and debug programs.

Step 8: Stop the debug session by clicking on the red box.

Step 9: Download the zip file: EEEN301 lab2 pt2.zip and load into Code Composer Studio.
In the Project Explorer, this will open a project titled “ASMtriall”. Double click on the
project to make it active. Examine the contents of the file “ASMCODE.c”. This file
demonstrates how you can insert assembly code instructions into a C project.

Step 10: We would now like to debug this code. Unfortunately, by default this project is
configured to build and debug using the TI compiler, not the GNU Linaro compiler that we



used in Lab 1. Launch the debugger, and see what happens. If the TI compiler is used, you
will receive an error!

Step 11: Let’s change the build configuration now, and confirm that we are using the Linaro
compiler. Click the drop-down arrow beside the "Build” Hammer A ~ and click on the
option “Debug” from the menu that appears. To confirm we are using the correct compiler,
in the “Project” menu, click on “Properties”. Under “General” ensure that configuration
“Debug” is selected. Under “Compiler version” ensure that the “Linaro” compiler is selected
from the drop-down menu. Under “Connection” ensure that the “SEGGER J-Link Emulator”

is selected from the drop-down menu. Your screen should appear similar to the image below.
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Runtime support library: | libc.a V‘ Browse...
'/?:‘ Show advanced settings Cancel

Once your screen looks like the image above, click “Apply and Close” to save the
configuration.

Step 12: Launch the debugger, expand the register window and then single step through the
program. In this example you should notice that the “Z” flag in the “CPSR” register changes.
Try changing the ADDS instruction to just ADD and see what happens to the flags during

execution.

Question 2. What is the difference in behaviour between the ADDS and ADD instructions?



Step 10: Alter the assembly language code so that while single stepping through it you set
the “N” status bit.

Step 11: Relaunch your debug session and then in the C code or the disassembly window,
double click on the left-hand side of the line number or address. You should see a small
symbol appear. This is a breakpoint. Click the green run (arrow) button to run the program
without single stepping and you will see that the program stops executing at the breakpoint.
This is a very useful feature to see the state of the processor and memory when you have
reached a specific point in the code. Breakpoints can be set, removed and disabled via the

run menu.

Step 12: Reactivate the project EEEN301 lab1 pt2 and launch debug. Set a breakpoint at line
28 of the C code. Click the green run (arrow) button to run the program and you will see that
the four LEDs will light up and the program will halt execution at the breakpoint. Click on
the step over arrow (F6) a few times and observe the progression through the set of

GPIO_clIrPin function calls. You will also notice the LEDs turning off.

Question 3. List the debug capabilities of the JTAG port.
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